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Introduction

Welcome to the O&O RescueBox!

Thank you for your trust in our products. We are thrilled to present you with the new 
O&O RescueBox. This product contains three world-class O&O Tools for recovering data:
• O&O UnErase 4
• O&O FormatRecovery 4
• O&O DiskRecovery 4

These programs are available on two CDs: On one as an installable Windows version and on 
the other as part of boot CD, bootable on systems without any installed operating system.
The following chapters have been designed to give you step-by-step instructions on how 
best to use this product for optimal results. Detailed information on the specifi c products 
can be found in the products' User Guides, also contained on these CD ROMs.

The individual products in the O&O RescueBox compliment each other with respect to 
their limitations and functionality. By owning all three, you have the best chance possible of 
recovering your lost fi les quickly and safely.

We hope you enjoy using the O&O RescueBox. If you have any questions regarding our 
products or licensing, please do not hesitate to contact us.

Your O&O Software Team
www.oo-software.com
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O&O RescueBox Contents

The O&O RescueBox consists of two CDs:
• O&O Recovery CD
• O&O Sampler CD

The O&O Recovery CD contains three full version products:
• O&O UnErase 4 
• O&O FormatRecovery 4
• O&O DiskRecovery 4

The O&O Recovery CD is a bootable CD which can be used to launch O&O UnErase 4, 
O&O FormatRecovery 4, and O&O DiskRecovery 4. An installed version of Microsoft Win-
dows is not required.

O&O Sampler CD contains, in addition to the three full version data recovery products, 
additional O&O products in trial version form. These additional software products require 
a Windows installation and CANNOT be started directly from the CD.

O&O DiskRecovery, O&O FormatRecovery, and O&O UnErase are three separate software 
products that are designed to compliment each other.

If O&O UnErase is unable to fi nd your missing data, O&O FormatRecovery or O&O Disk-
Recovery could still possibly be of help. Here are a few typical application examples to 
illustrate the differences between the software programs.

Installation and System Requirements

Differences between O&O UnErase, O&O FormatRecovery and 
O&O DiskRecovery



O&O 
UnErase

O&O Format-
Recovery

O&O Disk-
Recovery

Files were accidentally deleted from 
the Recycle Bin.

x x x

A virus or malicious software caused 
damage to some data and now some 
fi les or folders are missing.

x x x

A drive was formatted  x x

Windows is saying that the drive has 
to be reformatted.

 x x

The storage volume was reformat-
ted and the fi les were heavily frag-
mented.

 x  

O&O UnErase did not produce the 
desired results.

 x x

Windows can no longer access the 
hard drive.

  x

No fi le system is present on the 
drive.

 x x

O&O FormatRecovery and O&O Un-
Erase did not product the desired 
results.

 x

A new operating system was acci-
dentally installed.

 x

Data recovery with O&O products is 
not possible.
The storage volume is defective.

 
Contact O&O Services by e-mail a:

www.oo-services.com

Installation and System Requirements l 3User's Guide for O&O RescueBox 4
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O&O Sampler CD

The O&O Sampler contains an interactive presentation of O&O Software's current software 
line. The O&O Sampler CD usually starts automatically as soon as it is inserted into the CD 
ROM drive. 

Using the O&O Sampler, it is possible to install the products contained in the O&O Rescue-
Box. In addition, the O&O Sampler gives you access to each product's User's Guide and 
other useful information about O&O Software's excellent “Tools for Windows”.

The other O&O products included on the O&O Sampler can be installed and used as trial 
versions. Please feel free to test these products for 30 days free of charge and obligation.

System Requirements
The products contained on the O&O Sampler CD are compatible with: 
• Windows Vista
• Windows XP 
• Windows Server 2003
• Windows 2000 

Administrative Privileges
In order to install and run the products on the O&O Sampler CD it is necessary for you to 
be a member of the local administrator group or possess an equivalent level of privileges. 
If you are a domain administrator, then you usually posses the adequate level of adminis-
trative privileges.

Installation

 Note:
 The information contained in the following chapter will not be relevant to you if you are 
 using O&O products as part of the O&O Recovery CD. Installation is only necessary if 
 you are planning to use these software products from within Windows.

The products on the O&O RescueBox Sampler CD can be installed individually. Please fol-
low the directions below to install any one of the products:

1. Start the computer on which you would like to have the product installed, load Windows 
 (usually automatic), and log-in as a user with administrative privileges.
2. Insert the O&O Sampler CD “Tools For Windows” from the O&O RescueBox into your 
 CD-ROM drive. The O&O Sampler will start automatically.
3. In the Sampler CD's menu, click on the button labeled “O&O RescueBox” to display the 
 products contained in the O&O RescueBox. 
4. Now select the product you would like to have installed from the list and click Install 
 Now. The software will be installed.
5. After the installation software has been successfully initialized, please follow the on-
 screen instructions to complete the installation.
6. After its successful installation, the product will be launched and its the O&O Registra-
 tion Assistant will appear.



If a previous version of the product you would like to install is already present on your com-
puter, please uninstall the previous version, before attempting to install the new version.

Upgrade

 Note:
 The information contained in the following chapter will not be relevant to you if you are 
 using O&O products as part of the O&O Recovery CD. Installation is only necessary if 
 you are planning to use these software products from within Windows.

When upgrading an O&O software product from a previous version to the current one, 
please take note of the following steps:
1. Please remove the previous version from your computer. The Installation software for 
 the new version can detect the presence of a previous version and will notify you to have 
 it removed.
2. Install the product as described above in the chapter entitled  “Installation”.
3. After the its successful installation, the new product version will be launched and the 
 O&O Registration Assistant displayed will appear.

Registration

 Note:
 The information contained in the following chapter will not be relevant to you if you are 
 using O&O products as part of the O&O Recovery CD. Installation is only necessary if 
 you are planning to use these software products from within Windows.

Whenever you start an unregistered O&O product, you will be asked to complete the 
product's registration and enter a registration code. You may test the software for 30 days 
free of charge and obligation. By selecting the option “Buy Now”, you will be forwarded to 
the O&O Website for more information on the purchase of your product's full version. The 
O&O Online Shop offers you the option to purchase software immediately via the internet.

The O&O Registration Assistant allows for a simple and uncomplicated registration process. 
When you click on Enter Registration Code, a dialog box will appear. In the registration 
dialog you can enter your registration code that you received when you purchased your 
O&O product. Please make sure that your do not confuse the letter “O” with zeros or enter 
in any empty spaces.

More in-depth information regarding the registration of individual products contained in 
the O&O RescueBox can be found in the product's User's Guide.
If you run into any problems during registration, please contact the support team at 
O&O Software.
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Uninstallation

 Note:
 The information contained in the following chapter will not be relevant to you if you are 
 using O&O products as part of the O&O Recovery CD.

To remove one of the products contained in the O&O RescueBox from your system, open 
the Control Panel under the heading Settings in the Start Menu and double-click the icon 
Add or Remove Programs. 
Please select the desired O&O software product from the list of installed software and click 
on the Add/Remove-button. 

 Note:
 Products contained in the O&O RescueBox can only be installed or removed individ-
 ually. The license keys for the software in the O&O RescueBox are provided after the 
 successful purchase of the software.

O&O Recovery CD

System Requirements
To work with the programs contained in the O&O RescueBox Recovery CD, no installed 
operating system is necessary.

To start the O&O RescueBox Recovery CD, your computer must have a bootable CD ROM 
drive installed. It may be necessary to update your computer's BIOS settings.

For more information on making changes to those settings, please consult the documenta-
tion for your BIOS from your motherboard's manufacturer.

Starting the O&O Recovery CD

Booting from the CD
Please confi rm that you system can be booted from the CD. If not, it may be possible to 
activate this startup function from your system's BIOS. For more information on making 
changes to those settings, please consult the documentation for your BIOS from your 
motherboard's manufacturer. 

Insert the O&O Recovery CD in your computer's CD/DVD drive.

Start or restart your computer. The O&O RescueBox will be started from the O&O Recovery 
CD. This process could take a few moments to complete. After the software has been loa-
ded, you will be asked to select language, time zone, country, and keyboard layout.
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Selecting Your Regional Settings.

At this point it is possible to activate a network connection by selecting the option “Initiali-
zing Network Connection…”.

If a network connection cannot be created, it could be due to the fact that your network 
adapter (card) is not supported. If this is the case, the following error will appear:
 

Error: Network cannot be initialized.
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Starting Programs under Windows
The programs from the O&O Recovery CD can also be started under Windows direct from 
the CD, with no need for prior installation. To do so, simply insert the O&O Recovery CD into 
your computers CD/DVD drive once Windows has started. Should the CD fail to start up, 
you should check your settings and make sure the Windows Autoplay function is activated.
 

O&O RescueBox First Page

Starting Individual Data Recovery Products
By clicking on a product name in the fi rst page, additional information about that product 
will appear. 

Click then further on the product name in the next page to launch the desired product. To 
view the help product for this program, click Show User´s Guide.
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Starting Data Recovery Software

 Note:
 The O&O RescueBox Recovery CD is built using “Windows Preinstalled Edition”. Due to 
 technical limitations, any computer running this operating system longer than 24 hours 
 will be automatically rebooted without warning. 
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About O&O UnErase 

Whether it be those accidentally deleted text documents or those great photos from you 
last vacation: With its Explorer-like fi le structure, O&O UnErase enables you to navigate 
through your deleted fi les as if they had never been deleted. With one click of the mouse 
you can restore single fi les or entire folders. Never before was the restoration of deleted 
fi les so easy and intuitive to operate. O&O UnErase can restore all data stored on drives 
recognized and monitored by Windows.

The online software documentation is your best source for all details regarding the opera-
tion of O&O UnErase. Access to this documentation can be made through the program 
group in the Start Menu or through the Help menu in O&O UnErase itself. The software's 
internal Help fi le can also be reached by hitting the F1 key while the O&O UnErase is run-
ning.

 Note:
 The complete O&O UnErase User's Guide can be found on the O&O RescueBox Sampler 
 CD. To open this fi le, simply click on “View Userguide” in the O&O Sampler.

Main View

The Main View in O&O UnErase behaves very similarly to Windows Explorer, enabling you 
to easily use the program with only little or no previous knowledge.
The Main View is divided into three vertically tiled panes:
• Frequently used commands and settings are accessible through the pane on the left. 
 These commands are also accessible through the Toolbar or the Context Menu.
• The List of drives and directories in the middle pane enables an easy navigation through 
 existing and already-deleted fi les very similar to Windows Explorer.
• The List of Folders and Files on the right-hand side gives you all pertinent fi le information 
 regarding the selected existing and deleted fi les.
 

O&O UnErase
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Main View of O&O UnErase 4

Status Bar
At the very bottom of the Main View the Status Bar can be found in which the progress of all 
running searches and other status reports are displayed.

Toolbar
The Toolbar is the fastest way to access the most important functions of O&O UnErase. All 
commands, however, can be accessed through the pull-down menus at the top of the Main 
View. Through the View menu you can customize the composition of the Toolbar to meet 
your needs.

All Toolbars Including the Quick Search Bar

O&O UnErase l 11User's Guide for O&O RescueBox 4



12 l O&O UnErase User's Guide for O&O RescueBox 4

Displayed from left to right:
• Search for a drive on the system.
• Open the Advanced Search dialog.
• Restore deleted fi les.
• Cancel current search.
• Go up one level.
• View Help.
• View program information.
• Switch views.
• Tiles
• Icons
• List
• Details
• Toggle task list.
• Displays only deleted fi les and folders.
• Toggle Filter function.

Filter
If you would like to limit the fi les displayed in the fi le list on the right-hand side, it is pos-
sible to use the Filter function. This feature may be activated through the View menu or by 
pressing the Filter icon in the Toolbar. When activated, a series of fi elds will appear in which 
specifi c text may be entered to narrow down the number of fi les displayed. As before, it is 
possible here to use place holders.

File List with Activated Filter Function

 Tip:
 In general, it is easier and faster to just use the Advanced Search function to fi nd and 
 display a specifi c set of fi les.

Searching for Deleted Files and Folders

To fi nd deleted fi les and folders on a drive, please follow the directions below:
1. Select from the list of drives on the system the drive which you would like to search.
2. From the File menu at the top of the screen select the command Search for deleted 
 fi les.
3. The search will now be initialized. You can follow the progress of the running search in 
 the Status Bar at the bottom of the screen.
4. After he search is completed, the fi les and folders found during the search will be mar-
 ked in both the list of drives and fi les with a red “X” or arrow.
 



Main View with Deleted Files and Folders

 Tip:
 You can also execute a Quick Search by way of the Search fi eld in the Toolbar. Just enter 
 the drive letter and the path of the directory you would like to search and press Enter on 
 your keyboard.

Canceling a Search

If you would like to cancel a Search, select Cancel search from the File menu or press the 
corresponding icon in the Toolbar. The search will then be canceled and the fi les and folders 
that have already been found will be displayed.

 

‘Cancel Search’ Icon in the Toolbar during a Search
 
 Tip:
 Alternatively you can use the keyboard shortcut Ctrl+Esc to interrupt a running search.
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Deleted Files and Folder Designations

The red “X” indicates a fi le or folder is deleted. A small “X” displayed with a folder indicates 
that deleted fi les have been found in this folder, although the folder itself is still intact.

Normally the original fi lenames of the deleted fi les can be restored. However, if this is not 
possible, the folders and fi les will be generically numbered and named by O&O UnErase.

Restoring Files and Folders

The next step after deleted fi les or folders have been found is to restore the ones you need 
(if this is possible).
1. Files and/or folders you wish to restore can be selected in either the middle or right-
 hand panes of the Main View.

 Tip:
 Please note that in the middle pane of the Main View only one single folder may be se-
 lected for restoration. In the right-hand pane it is possible to select more than one fi le for 
 restoration by pressing the Ctrl key on the keyboard while selecting multiple fi les. To 
 select all fi les in a specifi c older, use the keyboard shortcut Ctrl+A. 

2. Press the Restore icon on the Toolbar or select the corresponding heading in the Con-
 text Menu. 
3. It is now possible to select where the restored fi les are to be saved. As your target direc-
 tory, you may create a new folder or select one that already exists.
4. In order to avoid any possibility of data loss, it is advised that you save the newly resto-
 red fi les onto a different partition than the one where the fi les were originally stored. 
 Please be aware that it is possible to store the fi les onto a network drive as well.

 Tip:
 It is also possible to simply drag-and-drop deleted fi les and folders you would like to
 restore into a directory displayed in the Main View. The restoration of the deleted fi les 
 will automatically follow.

Icon Defi nition

The folder has been completed deleted (large red “X”)

The folder contains deleted fi les or folders (small red “X”)

This fi le has been deleted and can probably be restored (red arrow).
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Advanced Searches

With the O&O UnErase's Advanced Search function, you posses a powerful tool for quickly 
and securely fi nding deleted fi les. Through a series user-defi ned search parameters it is 
possible to considerably increase the precision of your search result.
 

Advanced Search Dialog 

Search Settings
The search settings dialog enables you to defi ne the drive or folder to be searched. If you 
would like to also search subfolders, select the option with the same name.

It is also a possibility to expand the search to include fi les that have not been deleted. To do 
so, please uncheck the option Only search for deleted fi les. If this option remains selected, 
only deleted fi les will appear in the search results.

Filename
In the fi eld called Filename, you can either enter an exact fi lename or a fi lename containing 
a placeholder. For example, “*.BMP” would indicate you only wanted to search for Bitmap 
images. 
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Letter capitalizations are not considered in by the search function. You can use the special 
characters “*” and “?”. “*”, however, can be used for multiple characters, whereas “?” may 
only stand for a single character.

Contained Text
An especially powerful option is searching for text contained in the fi le. If you are looking 
for a fi le but only can remember a fragment of its name or contents, then this could be very 
useful to you.

Using the Filter When Searching
In order to customize your search further, it is possible to use the Filter function.

File Size
Here you can limit the size of the fi les that are to be searched. Just enter a range in Kbytes 
in which the desired fi le might fi t.

Date
This option allows you to enter a range of dates pertaining to the fi le and defi ning how that 
date range is to be applied during the search:
• Created – Date when the fi le was fi rst created
• Modifi ed – Date when the fi le was last saved
• Accessed – Date when the fi le was last accessed

File Attributes
The search can also be narrowed down to looks for specifi c attributes of the desired fi le. You 
can select from three options regarding each specifi c attribute:
• Marked (Checked) – The fi le must exhibit this attribute.
• Unmarked (Empty) – The fi le may not exhibit this attribute.
• Marked Green – This attribute will not be considered as a search parameter.

Running an Advanced Search
To Run an Advanced Search you have three options:
• New Search – A search will be initialized and all previous search results will be lost.
• Add – The search will be initialized and the search results will be added to the search 
 results already displayed.
• Remove – The search will be initialized and those search results found will be fi ltered out 
 of the list of search results already displayed.

You may repeat the search function as many times as you like, adding or removing the 
results from the displayed list of search results as you go. While the search is running, the 
search dialog box will remain closed.

When you not long would like to run a search, you can close the search dialog by pressing 
the Close button.
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O&O FormatRecovery

About O&O FormatRecovery 

It's happened to the best of us: your hard disk is mistakenly formatted and important fi les 
can be deleted and presumed lost forever. Whether the result of a computer virus, a soft-
ware error, or user error, this can be devastating. Important documents and business data 
aside, in the age of digital photography the loss of an captured moment can be irreplace-
able. 

When such a disaster strikes, what can be done? Many users cut their losses and accept that 
their fi les are lost. However, this is not necessarily the way it has to be. Even when Windows 
does not offer a viable solution for the recovery of lost data (i.e. the Recycle Bin), there still 
is hope with O&O FormatRecovery, an easy and secure way to recover data you had thought 
was deleted. Accompanied by an on-screen assistant, you are guided through the data re-
covery process, step-by-step. When all is fi nished you will be able to use the once-deleted 
data just as before.

The online software documentation is your best source for all details regarding the ope-
ration of O&O FormatRecovery. Access to this documentation can be made through the 
program group in the Start Menu or through the Help menu in O&O FormatRecovery 
itself. The software's internal Help fi le can also be reached by hitting the F1 key while the 
O&O FormatRecovery is running.

 Note:
 The complete O&O FormatRecovery User's Guide can be found on the O&O RescueBox 
 Sampler CD. To open this fi le, simply click on “View Userguide” in the O&O Sampler.



Main View

 
O&O FormatRecovery Startup Dialog Box

Selecting a Drive

Select the drive where you would like to scan for deleted data. It is possible to select a 
partition (e.g. C: or D:) or an entire hard disk drive. In addition you can select any storage 
media, from USB sticks memory cards for digital cameras. Clicking Next will conclude the 
drive selection dialog.

By default, the unpartitionable areas of a hard drive, or those located past the partitioned 
areas of the disk, are hidden.

If you would like to add drives after O&O FormatRecovery has been loaded (e.g. USB stick 
or digital camera), click on Update Drives. The newly connected hardware will be loaded 
and displayed in the list of drives.

Drives can be scanned for previous partitions and fi les systems. This is necessary is, for exa-
mple, if a partition has been deleted or a volume has been reformatted with a different fi les 
system. To start the analysis of your storage volumes, click Analyze Drive.
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 Note:
 Regardless of the size of the storage volume, this analysis could take some time.

Data Recovery Settings

After the drive has been selected, you have the opportunity to select some options that will 
affect the precision and duration of the scanning process. In most cases, the default settings 
are suffi cient and do not require any modifi cation.

Restore Empty Folders
With this option, you can have folders restored, even if they do not contain any data.
This allows for the restoration of complicated directory structures containing multiple in-
tertwined folders.

Restore Empty Files 
With this option, you can have fi les restored, even if they do not contain any data.

Restore system and hidden fi les  as they are
This option allows for the restoration of system fi les and hidden fi les with their original 
attributes intact.

When this option is not selected, these fi les would be restores as “normal” fi les (Not system 
fi les, and not hidden). 

 Note:
 Please consult your folder options in Windows when modifying this setting. It is possible 
 that fi les will not be visible after they have been restored.
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Selection Data Recovery Options

Additional Recovery Settings

Drive Errors
This option allows you to instruct the software to ignore areas of the storage volume where 
drive errors have occurred.

Automatically Saving Files After They Are Found
If you would like to execute an unsupervised scan, it is possible to instruct O&O Format-
Recovery to save and restore all of the scan results automatically. This can save time. If you 
would like to select this option, your next step will be to defi ne a target folder. Once this is 
completed, the scan will be initiated. More information on this can be found in the section 
entitled “Saving Files”.

 Note:
 This function is not available in the trial version of the software.
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Running and Interrupting a Scan

During the scan you will receive information regarding the O&O FormatRecovery scan by 
way of a status dialog box. In it you will fi nd the overall progress of the scan and the number 
of fi les found to this point.

O&O FormatRecovery can be Minimized in to the System Tray. Pressing Cancel will interrupt 
the scan. When the scan is interrupted you will be returned to the previous page of the assis-
tant where you will be given the option of resuming the scan or running it again.

Selecting Files for Restoration

After the scan has been completed, all found fi les, regardless of their respective save lo-
cations, are displayed on the left-hand side. When you are fi nished selecting the fi les for 
restoration, click Next to continue. Click the check-box next to the drive's letter to have 
all of the contained fi les restored. In some circumstances, the sorting and listing of a large 
number of fi les can take some time.

 
Selecting Files
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 Note:
 All found fi les on the scanned drive are displayed here in the list. These consists of all 
 fi les and folders visible to Windows. This list does not indicate, however, whether speci-
 fi c fi les or folder restorable or not.

Selecting a Target Folder

To recover selected fi les you need to enter a saving location. By default your ‘My Do-
cuments’ folder, but any folder, including network folders, may be selected for this. 
O&O FormatRecovery automatically creates a subfolder into which the recovered fi les are 
saved. Because an individual subfolder is created for every fi le type recovered, it is advised 
that you select a target folder that is new or empty. In addition, it is possible to create a 
report regarding the completed data recovery.

Please note that you will not be able to save the recovered fi les onto the same partition 
where the deleted data was originally located. Also do not forget to make sure you have 
enough storage capacity on disk to facilitate the newly recovered fi les.

Click Next to initiate the recovery of data.

Creating a Report

Activating this option will enable you to view a detailed report regarding the completed 
data recovery session. You can have this report saved to a different target folder as that 
in which the recovered fi les are to be saved. By default, the report will have the fi lename 
“oofr_report.rtf”. 

The reports are saved in Rich Text Format (RTF) and can be viewed and printed with the 
help of applications such as WordPad, Microsoft Word, or any other text editing programs.

Saving Files

While the recovered fi les are being saved to their target folder, O&O FormatRecovery keeps 
you up-to-date by way of a convenient dialog box. Information, such as overall progress and 
the total size of the saved fi les, is displayed in real-time as the operation progresses.

The elapsed time, as well the estimated time remaining, can also be found here.

O&O FormatRecovery can be Minimized in to the System Tray. Pressing Cancel will inter-
rupt the saving operation. When the operation is interrupted you will be returned to the 
previous page of the assistant where you will be given the option of changing the target 
directory and reselect the fi les to be recovered. Please note that all fi les that have already 
been successfully saved will be unselected so that you can continue to save fi les where you 
left off.
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Completing the Data Recovery

After the successful recovery of fi les is completed, a summary of the data recovery will ap-
pear. From here you can Open Target Folder and immediately access the restored fi les.
By clicking Finish O&O FormatRecovery will be closed.
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About O&O DiskRecovery

It's happened to the best of us: with the blink of an eye important fi les can be deleted and 
presumed lost forever. Whether the result of a computer virus, a software error, or user 
error, this can be devastating.

When such a disaster strikes, what can be done? Many users cut their losses and accept that 
their fi les are lost. However, this is not necessarily the way it has to be. Even when Windows 
does not offer a viable solution for the recovery of lost data (i.e. the Recycle Bin), there is 
hope with O&O DiskRecovery, an easy and secure way to recover data you had thought 
were lost. O&O DiskRecovery intensely combs storage volumes for lost data and can res-
tore fi les other software programs cannot.

The online software documentation is your best source for all details regarding the ope-
ration of O&O DiskRecovery. Access to this documentation can be made through the pro-
gram group in the Start Menu or through the Help menu in O&O DiskRecovery itself. The 
software's internal Help fi le can also be reached by hitting the F1 key while the O&O Disk-
Recovery is running.

 Note:
 The complete O&O DiskRecovery User's Guide can be found on the O&O RescueBox 
 Sampler CD. To open this fi le, simply click on “View Userguide” in the O&O Sampler.

Starting O&O DiskRecovery

As soon as O&O DiskRecovery starts, it is possible to begin a new data recovery session or 
continue one you have saved. Clicking Next will take you to the Drive Selection dialog box. 
O&O DiskRecovery may be Cancelled at any time.

Loading a Saved Data Recovery
• Select Load Data Recovery and select the data recovery fi le. Such a fi le generally has the 
 extension DRD.
• The data recovery information will be loaded and you will then be able to continue with 
 your saved settings.

If the data volume on which you would like to recover data is not present on your system, an 
error message will appear.

 

O&O DiskRecovery
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O&O DiskRecovery Startup Dialog Box

Selecting a Drive

Select the drive where you would like to scan for deleted data. It is possible to select a 
partition (e.g. C: or D:) or an entire hard disk drive. In addition you can select any storage 
media, from USB sticks memory cards for digital cameras. Clicking Next will conclude the 
drive selection dialog.

By default, the unpartitionable areas of a hard drive, or those located past the partitioned 
areas of the disk, are hidden. To reverse this, unselect the option Hide unpartitionable 
areas.

Differing from unpartitionable areas, unpartitioned areas on the hard disk can also exist 
under some circumstances. Although these areas on the disk cannot be accessed by Win-
dows, O&O DiskRecovery is able to scan these regions. These areas are listed in the list of 
partitions as RAW or “unpartitioned”.

If you would like to add drives after O&O DiskRecovery has been loaded (e.g. USB stick or 
digital camera), click on Update Drives. The newly connected hardware will be loaded and 
displayed in the list of drives.
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O&O DiskRecovery Scan Settings

After drive selection you will be able to defi ne the settings that will have a huge effect on 
the precision and length of the scan. In addition you can lay down a minimum length for text 
fi les. If a device, such as a hard drive or USB stick, has been selected and not a partition, 
the options O&O SmartScan and O&O RawScan are supported and cannot be selected. 
However, the default settings are generally suffi cient for most cases and therefore probably 
do not need to be changed.

Maximum Scan Depth for Recovering Data (O&O DeepScan)
Activate this option when you are scanning for especially small fi les. Please note that the 
O&O DeepScan requires more time to be completed.

Ignoring Existing Files (O&O SmartScan)
A common problem that occurs with data recovery is that not only deleted fi les are reco-
vered. In addition, existing fi les are recovered which can mean tedious work for you when 
you have to fi lter through those fi les that already exist on your system. The O&O SmartScan 
takes over this job for you so that only deleted fi les are found and restored. This can greatly 
accelerate the data recovery process, depending on the settings.

Please note that this option is only available when scanning partitions and not entire de-
vices.

Leaving Out the File System During the Scan (O&O RawScan)
If the partition on which you would like to recover data has been formatted (possibly with 
another fi le system), O&O DiskRecovery can be triggered to not scan the fi le system. This 
can increase the duration of the scan. 

Please note that this option is only available when scanning partitions and not entire de-
vices.

Limiting the Scan to File of a Specifi c Size
This function limits the scanning sequence to notice only fi les to fi les smaller than a set num-
ber of Megabytes. This maximum value can be set anywhere between 1 and  1024 MB.
By default, all recoverable fi les, regardless of their size, are scanned. Using this function will 
conserve system resources and possibly accelerate the entire scanning operation.

Minimum Length for Text Files
O&O DiskRecovery can recognize a number of different text fi les (HTML, source text fi les 
etc.). The default value of 512 characters means that all text fi les that consist of 512 cha-
racters or less will not be picked-up by the scan. If you would like to set this value lower, you 
can do so here. Please note that the minimum value is 16 characters; the smaller the value, 
the longer the scan duration.

 



Defi ning the Scan Settings

Running and Interrupting a Scan

During the scan you will receive information regarding the O&O DiskRecovery scan by way 
of a status dialog box. In it you will fi nd the overall progress of the scan, the progress per-
taining to a specifi c fi le, and the number of fi les found to this point.

The elapsed time, as well the estimated time remaining, can also be found here.

O&O DiskRecovery can be Minimized in to the System Tray. Pressing Cancel will interrupt 
the scan. When the scan is interrupted you will be returned to the previous page of the as-
sistant where you will be given the option of resuming the scan or running it again.

Selecting Files for Restoration

After the scan has been completed, the fi les found will be displayed in two lists; the list to 
the left displaying the types of fi les found, the one on the right showing the actual fi les of 
this type found. By selecting a specifi c fi le type on the left, the corresponding list on the 
right will change. Depending on which list is activated, the commands Select All, Select, 
and Unselect can be used.
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When your selections are made, click on Next to continue to the next step.

 Note:
 In the Personal Edition the maximum number of fi les that may be restored in a single 
 data recovery is 100. In both the Admin and Tech Editions of the software there is no 
 limit to the number of fi les restored in a single data recovery.

 

Selecting Files

For many image and text fi les, it is possible to view an preview before they are restored.
The preview must be activated. First select to the left a fi le type group and then click the 
Preview button. If the button is grayed-out, these types of fi les cannot be previewed.
With the preview function active, click on the fi le you would like to preview. The preview will 
appear in the space to the left of the fi le list.
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Preview (Image File)

To deactivate the preview function, simply click the Preview button one more time.

 Note:
 The fact that a preview is not available for some fi les does not rule out the chance for a 
 successful and fl awless restoration of those fi les. This function should not be seen as a 
 way to judge the quality of a pending restoration, but rather as a means to make the fi le 
 identifi cation process easier.

Filter
With the Filter option it is possible to include or exclude specifi c fi les from the list depen-
ding on their size. To do so, enter the size range in which the desired fi les should fall. You 
can also stipulate whether the fi lter should consider all fi les, only those previously selected, 
or only those you previously left unselected.

The command Select highlights all corresponding fi les for restoration. Unselect, in con-
trast, removes those highlights.
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Applying a fi lter

Selecting a Target Folder

To recover selected fi les you need to enter a saving location. By default your ‘My Do-
cuments’ folder, but any folder, including network folders, may be selected for this. 
O&O DiskRecovery automatically creates a subfolder into which the recovered fi les are sa-
ved. Because an individual subfolder is created for every fi le type recovered, it is advised 
that you select a target folder that is new or empty. In addition, it is possible to create a 
report regarding the completed data recovery.

Please note that you will not be able to save the recovered fi les onto the same partition 
where the deleted data was originally located. Also do not forget to make sure you have 
enough storage capacity on disk to facilitate the newly recovered fi les.

Click Next to initiate the recovery of data.

Creating a Report
Activating this option will enable you to view a detailed report regarding the completed 
data recovery session. You can have this report saved to a different target folder as that 
in which the recovered fi les are to be saved. By default, the report will have the fi lename 
“DiskRecoveryReport.rtf”. 

The reports are saved in Rich Text Format (RTF) and can be viewed and printed with the 
help of applications such as WordPad, Microsoft Word, or any other text editing programs.

Saving Files

While the recovered fi les are being saved to their target folder, O&O DiskRecovery keeps 
you up-to-date by way of a convenient dialog box. Information, such as overall progress and 
the total size of the saved fi les, is displayed in real-time as the operation progresses.

The elapsed time, as well the estimated time remaining, can also be found here.
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O&O DiskRecovery can be Minimized in to the System Tray. Pressing Cancel will interrupt 
the saving operation. When the operation is interrupted you will be returned to the previous 
page of the assistant where you will be given the option of changing the target directory 
and reselect the fi les to be recovered. Please note that all fi les that have already been suc-
cessfully saved will be unselected so that you can continue to save fi les where you left off.

Completing the Data Recovery

After the successful recovery of fi les is completed, a summary of the data recovery will ap-
pear. From here you can Open Target Folder and immediately access the restored fi les.

By clicking Finish, O&O DiskRecovery will be closed.
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Technical Support

To receive more information about O&O RescueBox, please visit our website, 
www.oo-software.com, and get the latest information about product developments and 
support. Also included on our website are regularly updated FAQs and Knowledge Bases 
that offer the most common problems and questions regarding our products.

All registered customers receive installation and product support free of charge for the fi rst 
90 days after registration. When contacting our support department, please do not forget 
to have your registration code ready. 

In addition, it may be helpful to read our frequently asked questions (FAQ) section of our 
website before you contact our support department. It is always possible that your specifi c 
question or problem may have already been addressed.

Authorized Resellers

For answers to all questions regarding the licensing and purchase of our software products, 
our authorized reseller partners in over 30 countries stand ready to assist you. Their names 
and addresses may be found at our website under the 'Purchase' heading. We would also 
be more than happy to assist you in fi nding the partner closest to you.

O&O Software GmbH
Am Borsigturm 48
13507 Berlin
Germany

Tel  +49 (0)30 4303 4303
Fax +49 (0)30 4303 4399

E-mail info@oo-software.com 
  sales@oo-software.com
Web www.oo-software.com

Support and Contact
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End-User License Agreement

IMPORTANT – PLEASE READ CAREFULLY

This end user license agreement is a legally binding contract between yourself (as a natural 
or a legal person) and the company O&O Software GmbH (O&O) for the software product 
named above. By starting and using the software product, you declare your agreement with 
all conditions of the license agreement.If you do not agree with the conditions of the license 
agreement, you are not entitled to install or use the software product. Should this be the 
case, you can return the software product along with a copy of the invoice or receipt to the 
distributor from whom the product was purchased in exchange for a full refund. The soft-
ware product is protected by copyright laws and international copyright contracts as well as 
other laws and agreements concerning intellectual property.

IMPORTANT NOTE 

The Microsoft® Windows® Preinstallation Environment software included with this device or 
software may be used for boot, diagnostic, setup, restoration, installation, confi guration, 
test or disaster recovery purposes only.

 Note:
 THIS SOFTWARE CONTAINS A SECURITY FEATURE THAT WILL CAUSE END USER’S 
 SYSTEM TO REBOOT WITHOUT PRIOR NOTIFICATION TO THE END USER AFTER 24 
 HOURS OF CONTINUOUS USE.

1. Subject of Agreement
The subject of this agreement is the computer program, the description there of and the 
user manual as well as any other accompanying written material. This will henceforth also be 
referred to as “software”. O&O wishes to point out that, at the current state of technology, it 
is not possible to create software that works perfectly in all applications and combinations. 
The subject of this contract is therefore a software program that is fi t for the purposes 
detailed in the description and the user manual. 

2. License Granting 
For the duration of this contract, O&O grants you the simple, non-exclusive, and personal 
right (henceforth referred to as “license”) to use a copy of the software on a single com-
puter. The repeated use of this software on multiple computers is prohibited (Floating Li-
cense), unless otherwise explicitly stated.

This product can only be used in accordance with the specifi c license purchased. The 
O&O RescueBox V4 is available in three (3) different license variations: 
(a) O&O RescueBox V4 Personal Edition
 You are authorized to use the software product on only one computer. The use of this 
 license in conjunction with services provided for a third-party is prohibited and is in vio-
 lation of the software license agreement. Additional limitations for this software product 
 may apply. For more information on this, please consult the software's documentation 
 provided with the product.
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(b) O&O RescueBox V4 Admin Edition
 You are authorized to use this software on all computers a) owned and licensed by a sin-
 gle company (a legal individual or multiple natural persons in a corporation)  and b) loca-
 ted in a single physical location. This license is bound to a single physical person and is 
 non-transferable, unless the transfer is carried out according to the process stipulated in 
 section 3.

(c) O&O RescueBox V4 Tech Edition
 You are authorized to use this software on all computers. This includes computers not 
 owned by the license holding company or individual (i.e. Service Technician License). 
 This license is bound to a natural individual and is non-transferable, unless the transfer is 
 carried out according to the process stipulated in section 3.

3. Description of further rights and limits 
The license-holder is prohibited from;
(a) Altering, translating, reverse-developing, decompiling or disassembling the 
 software without the advance written permission of O&O  
(b) creating products derived from the software or making copies of the written 
 material, translating or altering the written material or creating products 
 derived from the written material
(c) distributing copies of the software to third parties
(d) changing or removing the copyright mark on the copies of the software 
(e) renting out, - or lending the software 

The license holder is permitted to transfer all rights from this license agreement perma-
nently to another person, provided that the recipient also agrees to all conditions of this 
license. The license holder must use the software only in compliance with all relevant laws. 

4. Ownership of rights
Any ownership rights applying to the software, including but not limited to copyright laws, 
belong to O&O Software and those proprietors of any additional or integrated software 
included in this product. Any rights not explicitly claimed are reserved by O&O and those 
proprietors of any additional or integrated software included in this product. The purchase 
of a license for a product simply grants a right to use the software as described in the 
conditions of the license agreement. This does not imply a right to the software itself. In 
particular, O&O reserves all publication, multiplication, processing and utilization rights to 
the software. 

5. Reproduction
The software and accompanying written material are protected by copyright laws. The user 
has the right to create copies of the software for back-up and archiving purposes. He or she 
is thereby also obliged to reproduce O&O’s copyright mark on the physical medium or in 
the program. A copyright mark present in the software may not be removed. Copying or 
reproducing the software in original or altered form, or merged with or included in other 
software, is explicitly forbidden. 



6. Length of the Agreement
This agreement is valid indefi nitely. The right of a license-holder to use this software is 
removed automatically and without notice if he or she violates one of the terms of this 
agreement. At the end of the period of right to use, the license-holder is obliged to destroy 
the software, all copies of the software, and the written material. 

7. Compensation for Breach of Contract
O&O would like to point out that you are responsible for any damages arising from breach 
of copyright if you violate these contract terms.

8. Changes and Updates
O&O is entitled to update the software as it wishes. O&O is not obliged to make updated 
versions available to license holders who have not registered their product with O&O, or 
who have not paid the update fee. Any additional program code that is made available to 
you as an update is considered a part of the software and is therefore subject to the terms 
of this agreement. 

9. O&O’s Guarantees and Responsibility 
(a) O&O guarantees the original license-holder that the data medium carrying the software 
 is free of errors at the point of delivery, assuming normal operating conditions and a 
 normal level of maintenance. 
(b) If the delivered data carrier is faulty, the purchaser can demand a replacement during 
 the 24-month guarantee period. For this, he or she must return the data carrier, any 
 back-up copies and the written material along with a copy of the invoice or receipt to 
 O&O or to the dealer where the product was purchased.
 (c) If a fault as described in clause 9 b is not corrected by means of a replacement delivery 
 within a reasonable time period, the purchaser can demand either that the sale price be 
 reduced or that the contract be canceled.
 (d) For these reasons and for those mentioned in clause 1 of this contract, O&O accepts no 
 responsibility for mistakes in the software. In particular, O&O does not guarantee that 
 the software will meet the particular requirements and demands of the purchaser or that 
 it will function together with other software he or she has chosen. The purchaser is 
 responsible for the correct choice of software and the consequences of the use of that 
 software, as well as the results aimed at or intended. The same principle applies to the 
 written material that accompanies the software. If the software is fundamentally unfi t for 
 use as described in clause 1, the customer has the right to cancel the contract. O&O has 
 the same right should the creation of software that is fundamentally fi t for use as de-
 scribed in clause 1 not be practically possible.  
(e) O&O is not responsible for any damages, unless such damages are caused deliberately 
 or arise from gross negligence on the part of O&O. In contracts with traders, an assump-
 tion of responsibility for gross negligence is excluded. This does not apply to assurances 
 by O&O that refer to specifi c characteristics. Responsibility for damages not included in 
 such an assurance will not be accepted. 

10. Competency
If the license-holder is a registered merchant under German law, the law that applies to this 
contract is the law of the Federal Republic of Germany. In this case, the state and federal 
courts of the Federal Republic of Germany assume responsibility. 
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If you have any questions regarding the licensing of O&O software or you wish to contact 
O&O, please get in touch with us as follows:

O&O Software GmbH
Am Borsigturm 48
13507 Berlin
Germany

Tel  +49 (0)30 4303 4303
Fax +49 (0)30 4303 4399

E-mail info@oo-software.com 
  sales@oo-software.com
Web www.oo-software.com

36 l End-User License Agreement User's Guide for O&O RescueBox 4


	O&O RescueBox 4
	Table of Contents
	Introduction
	Welcome to the O&O RescueBox!

	Installation and System Requirements
	O&O RescueBox Contents
	Differences between O&O UnErase, O&O FormatRecovery and O&O DiskRecovery
	O&O Sampler CD
	System Requirements
	Installation
	Upgrade
	Registration
	Uninstallation

	O&O Recovery CD
	System Requirements

	Starting the O&O Recovery CD
	Booting from the CD
	Starting Programs under Windows
	Starting Individual Data Recovery Products


	O&O UnErase
	About O&O UnErase
	Main View
	Searching for Deleted Files and Folders
	Canceling a Search
	Deleted Files and Folder Designations
	Restoring Files and Folders
	Advanced Searches
	Search Settings
	Using the Filter When Searching
	Running an Advanced Search


	O&O FormatRecovery
	About O&O FormatRecovery
	Selecting a Drive
	Data Recovery Settings
	Additional Recovery Settings
	Running and Interrupting a Scan
	Selecting Files for Restoration
	Selecting a Target Folder
	Creating a Report
	Saving Files
	Completing the Data Recovery

	O&O DiskRecovery
	About O&O DiskRecovery
	Starting O&O DiskRecovery
	Selecting a Drive
	O&O DiskRecovery Scan Settings
	Running and Interrupting a Scan
	Selecting Files for Restoration
	Filter

	Selecting a Target Folder
	Creating a Report

	Saving Files
	Completing the Data Recovery

	Support and Contact
	Technical Support
	Authorized Resellers

	End-User License Agreement




